Oracle In-Memory Policy Analytics
Demonstration Walkthrough

December 2014
Who is this Demonstration Walkthrough For?

• This walkthrough is provided for anyone that wants to understand how to use Oracle In-Memory Policy Analytics to compare policy scenarios

• It gives an overview of the capabilities of Oracle In-Memory Policy Analytics using the provided sample myBenefits project and accompanying demonstration database

• Before following the walkthrough, ensure all installation tasks have been completed according to the Technical Installation Overview, including the sample database install

• For more information, consult the following resources:
  • Technical Installation Overview
  • Product Documentation
  • Features and Benefits Presentation
Before You Begin

• Create two accounts in Oracle Policy Automation Hub, with the following roles:
  – *paula*: With the roles Policy Author and Deployment Administrator
  – *adam*: With the role Analysis User
Demonstration Overview

- Deploy the MyBenefits Example
- Populate Analysis Workspace
- Compare a New Policy Model
- Understand How it Works
Deploy the MyBenefits Example
Deploy the MyBenefits Example

• Follow these steps:
  1. Download and install Oracle Policy Modeling
  2. Open the myBenefits Example Project
  3. Confirm Mapping Settings
  4. Deploy a Snapshot
1. Download and Install Oracle Policy Modeling 12.0.1

• Download OPM 12.0.1 from the Oracle Software Delivery Cloud:
  https://edelivery.oracle.com
  – Select Oracle Policy Automation Suite as the Product Pack and choose Microsoft Windows as the Platform, and choose Go

  – Find Oracle Policy Modeling (12.0.1) in the list, and download it

• Once downloaded, run the setup application and follow the prompts

• Note: Oracle Policy Modeling requires Windows Vista or later
2. Open the MyBenefits Example Project

- Run Oracle Policy Modeling using the installed application shortcut
- Choose Example Projects from the Project ribbon
- Search for myBenefits
- Select the example to create a copy of the project and open it
3. Confirm Mapping Settings

- Select the Data tab, and choose *Mapping Settings* from the ribbon
- Next to Connection, choose *change*
- Login to OPA Hub as *paula*
- Choose the *All Households Analysis* Input connection created during setup for the example_my_benefits TimesTen database
- Choose OK, and the data model will be retrieved from the Hub
- Make sure MYBENEFITS_GLOBAL is still selected as the Primary analysis table, and choose OK
4. Deploy a Snapshot

- On the Project tab, choose Deploy Snapshot from the ribbon
- Enter paula’s password
- The default deployment name is OK
- Make sure Activate Immediately is checked
- Choose Deploy
Populate the Analysis Workspace
Populate the Analysis Workspace

• Follow these steps:
  1. Create a workspace
  2. Create scenarios
  3. Create some charts
1. Create a Workspace

• Login to OPA Hub as *adam*
• Choose Workspaces
• Click to create a new workspace
• Enter details as shown
2. Create Scenarios

Original Policy scenario
- Choose Add Scenario
- From the Policy Model list, choose myBenefits
- Save and Close the scenario
This scenario simply uses the current policy settings as defined by the policy modeling project

No Heat and Eat scenario
- Choose Add Scenario
- From the Policy Model list, choose myBenefits
- Choose Heat and Eat policy in effect false
This scenario turns off the “heat and eat” policy that certain US states may have in place
2. Create Scenarios - continued

Mid Resource Thresholds scenario
• Choose Add Scenario
• From the Policy Model list, choose myBenefits
• Enter 1000 for SNAP household resource threshold
• Save and Close the scenario

This scenario has a medium resource threshold for eligibility

Low Resource Thresholds scenario
• Choose Add Scenario
• From the Policy Model list, choose myBenefits
• Enter 325 for SNAP household resource threshold
• Save and Close the scenario

This scenario has a low resource threshold for eligibility
2. Create Scenarios - summary

• Choose Manage Scenarios
• There should be four scenarios listed, as shown

<table>
<thead>
<tr>
<th>Status</th>
<th>Name</th>
<th>Policy Model</th>
<th>Heat and Eat Policy in effect</th>
<th>SNAP annual utility allowance</th>
<th>SNAP household resources threshold</th>
<th>SNAP standard monthly deduction</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Original Policy</td>
<td>myBenefits</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>No Heat and Eat</td>
<td>myBenefits</td>
<td>false</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Low Resource Threshold</td>
<td>myBenefits</td>
<td>-</td>
<td>-</td>
<td>325.00</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Mid Resource Threshold</td>
<td>myBenefits</td>
<td>-</td>
<td>-</td>
<td>1000.00</td>
<td>-</td>
</tr>
</tbody>
</table>
3. Create Some Charts

Add Simple Comparison Bar Chart

Choose the options shown below to Add a Total Payable - Original vs No Heat and Eat chart

Note that some states show a slightly lower total payment amount when No Heat and Eat policy is in effect
3. Create Some Charts - continued

Add Simple Comparison Table Chart

Choose the options below to create the *Resource Threshold Impact* table chart

This table chart compares the impact on various metrics of the mid and low thresholds against the original policy.
3. Create Some Charts - continued

Add Gender Comparison Bar Chart

Choose the options below to create the *Payout Impact by Gender* table chart

This chart is grouped by gender, comparing the average payout across the three selected scenarios.
3. Create Some Charts - continued

Add Break-down Pie Charts

Choose the options below to create two pie charts for Eligibility by State for the Mid and Low resource scenarios

- For this scenario: Mid Resource Threshold
- Compare this outcome: SNAP Eligible is true (count)
- For each value of: Location

- For this scenario: Low Resource Threshold
- Compare this outcome: SNAP Eligible is true (count)
- For each value of: Location
3. Create Some Charts - continued

Add a Table Breakdown Chart

Choose the options below to create a table that breaks down Threshold Impact by State

![Table Example](image-url)
3. Create Some Charts - summary

Your Workspace should now look something like this:
Compare Another Policy Model
Compare Another Policy Model

• Follow these steps:
  1. Modify the policy model (or create a new one)
  2. Deploy with a different name
  3. Use the policy model in scenarios
  4. Wait for scenario processing to complete
  5. View chart changes
1. Modify the Policy Model

• Open the myBenefits project in Oracle Policy Modeling
• Make a change to the Supplementary Nutrition Assistance Program rules e.g. by adding the highlighted row to the rule table shown below

```
<table>
<thead>
<tr>
<th>the household’s estimated monthly allotment for SNAP</th>
<th>the household may be eligible for SNAP if:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum(</td>
<td>the household may be eligible for SNAP</td>
</tr>
<tr>
<td>the maximum monthly allotment for SNAP for the</td>
<td>and the household’s location = “Texas”</td>
</tr>
<tr>
<td>household size * 1.1, 0)</td>
<td></td>
</tr>
<tr>
<td>Maximum(</td>
<td>the household may be eligible for SNAP</td>
</tr>
<tr>
<td>the maximum monthly allotment for SNAP for the</td>
<td>and the household’s location = “Texas”</td>
</tr>
<tr>
<td>household size - Trunc((the household’s net monthly</td>
<td></td>
</tr>
<tr>
<td>SNAP income * 0.3) + 0.99), 0)</td>
<td></td>
</tr>
<tr>
<td>unknown</td>
<td>otherwise</td>
</tr>
</tbody>
</table>
```

This fictitious change is designed to be obvious when charted, but is unlikely in reality!
2. Deploy with a Different Name

- Choose Deploy Snapshot from the Project tab
- Change the Deployment Name to, for example, Texas Change

- Make sure Activate Immediately is selected
- Enter paula’s password, and choose Deploy
3. Use the Policy Model in Scenarios

- Login as adam to OPA Hub, and choose Manage Scenarios from the Actions menu.
- Modify the No Heat and Eat Scenario as shown below, making sure to select the Texas Change policy model:

```
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNAP annual utility allowance</td>
<td>Currency</td>
<td></td>
</tr>
<tr>
<td>SNAP household resources threshold</td>
<td>Currency</td>
<td></td>
</tr>
<tr>
<td>SNAP standard monthly deduction</td>
<td>Currency</td>
<td></td>
</tr>
<tr>
<td>Heat and Eat Policy in effect</td>
<td>Boolean</td>
<td>false</td>
</tr>
</tbody>
</table>
```
4. Wait for Scenario Processing to Complete

- As soon as the scenario is Saved, processing will automatically start.
- Note that 1 scenario in progress is shown in the footer of the Manage Workspaces page, and Texas Increase scenario is shown with the refreshing symbol next to it.
- It won’t take long to complete processing (note that other work can continue while it does).
5. View Chart Changes

• Return to the Workspace page, and note that the first chart now shows Texas with a much higher total payout figure.

• Change the chart title to reflect it is now a comparison to the Texas Increase scenario, instead of No Heat and Eat.
Understand How it Works
Understand How it Works

To understand how it works:

1. Understand how each individual case is handled
2. Understand analysis input and output mapping
3. Understand workspace parameters
4. Understand how scenarios are processed
1. Understand How each Individual Case is Handled

• Included with Oracle In-Memory Policy Analytics is the Web Determinations interview application

• Every licensed In-Memory Policy Analytics user can interact with this interface

• This lets them understand how each deployed policy model processes the individual cases

• To use it, click the Interview link from the Deploy Snapshot dialog in Oracle Policy Modeling, or the Deployments page in OPA Hub

• The interview prompts for the data required by the policy model to reach the conclusions it defines

• In-Memory Policy Analytics does the same thing, but for hundreds, thousands or millions of cases
2. Understand Input and Output Mapping

• Input and Output mapping is essential to In-Memory Policy Analytics. The Mapping Settings define which analysis input table is associated to the Global entity in the OPA policy model.

• Each case must have enough input data to reach the decisions as defined by the policy model – to do so each base level input needs to be mapped in from the analysis input data source.
  
  **Tip:** If the analysis input data source does not have some required input information, rules can be added to the policy model to calculate automatic values as needed.

• The conclusions that are of interest for analytical purposes must also be mapped **out** – i.e. given a name that will appear in the workspace. These outcomes can then be used in charts.
3. Understand Workspace Parameters

- Workspace parameters are how analysis users that are not detailed policy experts can try out different scenarios without needing to create and deploy new policy models using Oracle Policy Modeling.

- Policy authors using Oracle Policy Modeling create named parameters before deployment, so they are available to analysis users when creating or modifying scenarios in OPA Hub Workspaces.

- Workspace parameters can override the default behavior of the policy model, and even cause entirely different branches of logic to be used, depending on how the policy model is written.
4. Understand How Scenarios are Processed

• Each time a scenario is added or changed, each row in the analysis input data is processed through the mapped inputs for that scenario’s policy model to generate each of the policy model’s mapped outcomes in the analysis output database.

• This processing is fast, but it can take a few minutes if there are a lot of outcomes and a lot of input data.

• Scenario changes include:
  – Scenario is added
  – Scenario’s policy model is updated
  – A parameter value in the scenario is changed

• **Tip:** If the analysis input data is changed, use the Restart All button on the Manage Scenarios page in OPA Hub to force all scenarios to be reprocessed.
For More Information
Additional Resources

• For more information, consult the following resources:
  • Product Documentation
  • Features and Benefits Presentation
  • Technical Installation Overview
  • OPA Discussion Forum
Social Media – Keep in Touch!

https://www.facebook.com/OraclePolicyAutomation

http://www.youtube.com/user/OraclePAVideos

https://twitter.com/OracleOPA

http://www.linkedin.com/groups/Oracle-Policy-Automation-3431282/about

https://blogs.oracle.com/OPA/

Hardware and Software
Engineered to Work Together